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Agenda 

 Documents 
 Overview 
 Rich Text Format (RTF) Documents 
 How to Edit RTF Documents  

 Adding or Removing Headers on RTF documents 
 How to Create, Attach, Change or Remove RTF Document 

Template Headers 
 General Changes/Updates 

 Reports  
 Fields  
 Screen  
 Other Updates 

 Training Schedule 
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WORKGROUP 
CHRONOLOGY 
DOCUMENTS  
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State Workgroup Documents 

 Some of the State HTML workgroup documents 
were changed to RTF documents because the 
original HTML implementation did not give users 
the intended flexibility within the document. 

 There are now two different formats for the 
Workgroup Chronology documents. 
HTML 
RTF 
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Two Types of State Workgroup 
Documents in Chronology 

 HTML documents  
 Protected text entered by the State is non-editable 

by users. 
 All merged fields on the Setup tab are protected 

text. 
 Text boxes  
 To enter text, you have to click on the pencil to open the 

editor. 
 Text is entered  in one text box at a time. 

 Cannot edit text that merges in from the Setup tab. 
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Two Types of State Workgroup 
Documents in Chronology 

 Rich Text Format (RTF) documents  
 Offers more editing flexibility within the document. 
 Users can insert text as needed. 
 Some merge fields can be edited. 
 Many documents were transitioned to the new RTF 

format. 
 Other documents used primarily by child protection, 

adult protection and licensing workers will transition 
to RTF format at a later date. 
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Example of HTML  Fields/Elements 

Merge fields 
 Agency 
 Parent 1 

Elements 
 Drop-down 

menus 
 Checkboxes 

Protected text. 
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Example of RTF  Fields 

Editable 
merge fields 
 Parent 1 
 Parent 2 

Add or 
remove most 
text in the 
document. 
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List of HTML Documents 

 
 Some 

documents 
remain in 
HTML format 

 See handout: 
 List of HTML 
 Documents in 
 Chronology. 
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List of RTF Documents 
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 80 related 

documents 
updated 

 See handout: 
List of Rich 
Text Format 
(RTF) 
Documents in 
Chronology. 
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Access the RTF Documents 

Search remains the same for all workgroup 
documents. 
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Type-Ahead Functionality 
 Type-ahead functionality available on the Document 

template field on the Setup tab, except in State Service 
Plans. 

 
Example: 
Enter part of the document name and click the search 
button. The document name displays in the Template Search 
list. 
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Access Documents 

To Access Documents: 
1. Right-click on the Chronology folder and select 

New Document. 
2. Use the type ahead feature by entering the 

name of the document in the Document 
template field and click the search button, or 
click the search button to get a complete listing 
of all documents. 
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RTF Document Editing Options 
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Users can 
 Edit Name merge fields 
 Copy and paste table rows 
 Add or remove spacing 
 Add or remove page breaks 
 Use hyperlinks and bookmarks 
 Change font style, size, color and other word 

processing options  
 No longer need to do this field by field 
 Edit and Print from the expanded view. 
 

 



Click the Editor button to Edit or Print 
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RTF Document 

Edits made on the 
document 
Added names 
 Increased font 

size and type 
Changed font 

color 
Deleted the lines 

when I entered 
the Guardian ad 
Litem’s 
information. 
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RTF Document 
Adding or Removing Text 
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RTF Document 
Adding or Removing Text 

The brackets display around merged fields. They are 
unseen in the main body of the text for a document; yet, the 
main body of text is still editable. 
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Add or Delete Text 

To Add or Remove Text in a RTF Document: 
1. From the Document tab, click Editor button. 
2. Add or delete text as desired. 
 Text displayed between an open and closed bracket 

is editable 
 Text displayed outside of the brackets is non-editable 

3. Click the File menu and select Save. 
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RTF Document Date Picker 
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Click the checkmark to save the date. 



How to Change the Date 
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Use New Date Picker 

To Select A Date: 
1. Click on the date picker in the RTF document. 
2. Select the date.  
 Today’s date is the default date, or 
 Enter a new date, or  
 Click on the date drop-down menu to access a full 

calendar and select a date. 
3. Click the checkmark to save the date. 
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Some Expanded Editor Options 

Normal word processing features. 
 Tab options on the RTF editor toolbar. 
 Additional menu options available on the ribbon 

beneath the selected Tab on the toolbar. 
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Document Opened in the  
Expanded Editor 
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Edit the RTF Document 

To Edit the RTF Document: 
1. From a completed Setup tab, click the 

Document tab.  
2. Click the Editor button and edit document as 

desired. 
3. Click the X to close the editor. 
4. Save changes. 
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New Document Tab Menu Options 
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New Document Tab Menu Options 

 Re-Merge Document  
 Clears any edits made to merge fields 
 Updates any merge fields that were changed in 

the database 
 Use to update the Header on an existing 

document.   
 

Warning: Typing immediately before or after the text 
is considered outside of the merge fields. This means 
that re-merging from the Setup tab will not affect edits 
before and/or after the merge field.  
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New Document Tab Menu Options 

 Reset to Template 
   Clears all edits to the document (text, spacing,   
   deletions, etc.) except merge fields.  
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Re-Merge or Reset the RTF 
Document 
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To Use Re-Merge Document or Reset to 
Template: 

1. From the Chronology folder, access the Action 
menu and expand the Documents folder. 

2. Select the document and then select Display 
Setup. 

3. Complete Setup tab. 
4. Click the Document tab. 



Re-Merge or Reset the RTF 
Document 
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To Use Re-Merge Document or Reset to 
Template Cont’d: 

4. Access the Action menu and select Re-Merge 
Document or Reset to Template. 

5. Review the warning message and select Yes or 
No to continue or cancel. 

6. Click the blue E to open the editor. 
7. Update document and Click Save. 



How to Edit RTF Documents Demo   
Available on Demand 

 Click on the link: How to Edit an RTF document. Follow 
the login instructions: Enter First Name, Last Name and E-
Mail Address. 

 
Or 
 
 Access iLinc recordings:   

1. Click on the following link: https://minnesota.ilinc.com/ 
(No need to sign in. Go to Step 2.)  

2. Click on the Public Sessions tab.   
3. Click on the Join tab.   
4. Find the session that you would like to watch.   
5. Click on the Open button for that session. The session 

will open in a new window.  
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https://minnesota.ilinc.com/perl/ilinc/lms/vc_launch.pl?activity_id=xmjbpzk&user_id=
https://minnesota.ilinc.com/


RTF Document Headers 
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The RTF documents need new RTF 
Headers attached.  

First Page Header is the only option 
available. 

Security Admin rights of Create 
Document Templates needed to 
create and attach the RTF Headers.  

 
 



Access RTF Document Headers 
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To Access RTF Document Template Headers: 
Access the Tools menu and select RTF 
Document Template Headers.  

 



Create RTF Document Headers 
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Create an RTF Document Header 
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To Create a RTF Document Header: 
1. Access the Tools menu and select RTF 

Document Template Headers. 
2. Access the Action menu and select New RTF 

Document Template Header. 
3. Enter a title for the Header in the Template 

Name field and save. 
4. Click on the blue E to expand the editor. 
5. Create the Header in the editor. 
6. Click X to close the editor and click Save. 

 



Attach RTF Document Header 
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Attach RTF Document Header 

To Attach the RTF Document Header: 
1. Access the Tools menu and select RTF 

Document Template Headers. 
2. Highlight the Header in the Tree View or grid. 
3. Select the checkbox next to each document 

that will use the selected Header. 
4. Click Save. 
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Change an Attached  RTF 
Document Header 
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To Change an Attached RTF Document 
Header: 
1. Access the Tools menu and select RTF 

Document Template Headers. 
2. Highlight the new Header in the Tree View or 

grid. 
3. Check the checkbox next to each document 

to change  the Header. 
4. Click Save. 
 



Remove an Attached  RTF 
Document Header 
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To Remove an Attached RTF Document 
Header: 

1. Access the Tools menu and select RTF 
Document Template Headers. 

2. Highlight the Header in the Tree View or 
grid. 

3. Uncheck the checkbox next to each 
document to remove the Header. 

4. Click Save. 



Remove an Attached  RTF 
Document Header 

Hints:  
 If the user finalizes a document and the 

template Header is later removed, the finalized 
document will retain the original header.  

 If the user did not finalize the document and 
the template Header is updated or removed, 
the template will generate with the newly 
associated header or no header once the new 
Re-Merge Document function is used.  
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RTF Document Headers Tips 

 The user must have the security function 
“Create Document Template” in order to create a 
RTF Header. 

 Do not copy and paste Headers used in the 
HTML Document Template Editor.  Most of the 
fields used, including tables, do not translate 
into the RTF editor. 

 Use the “Re-Merge Document” option to update 
the Header on an existing document.   
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RTF Document Headers Tips 

 To insert an image file 
(e.g. jpg, png, etc.), use 
the editor option “Inline 
Picture” instead of the 
“Picture”.  This prevents 
overlapping that may 
occur when the 
document is created in 
Chronology or the 
Client folder. 
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How to Create, Attach, Change or Remove RTF 
Document Headers Demo  

Available on Demand 
 Click on the link: How to Create, Attach, Change or 

Remove a RTF Document Template Header. Follow 
the login instructions: Enter First Name, Last name 
and E-Mail Address. 

 Or 
 Access iLinc recordings:   

1. Click on the following link: https://minnesota.ilinc.com/ 
(No need to sign in. Go to Step 2.)  

2. Click on the Public Sessions tab.   
3. Click on the Join tab.   
4. Find the session that you would like to watch.   
5. Click on the Open button for that session. The session 

will open in a new window.  
 
 
 

 
 
 

SSIS Worker V14.3 Release Training                  September 2014 

43 

https://minnesota.ilinc.com/perl/ilinc/lms/vc_launch.pl?activity_id=xmjbypf&user_id=
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https://minnesota.ilinc.com/perl/ilinc/lms/login.pl?template_dir=minnesota


Known Defects 

Document Templates 
 Documents and Local Agency Service Plans 

Printing a document or service plan twice causes an error 
message to display. The error message prevents printing the 
document or service plan.  
 Workaround: Refresh the screen after printing.  
 

 Template Search 
When viewing RTF documents in the Template Search 
preview screen, right-clicking on a hyperlink displays a menu 
with “Open hyperlink” enabled. Clicking on the “Open 
hyperlink” does nothing. 
 Workaround: Do not click on the “Open hyperlink” menu 

option.  
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Known Defects 

Document Templates Cont’d 
 Spellchecker 

The checkboxes are seen as spelling errors. 
 Workaround: Add the letters “o” and “x” to the 

your custom dictionary.  
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Summary  

 What stayed the Same? 
 Workgroup documents are still accessed through 

Chronology. 
 Users should still finalize (or activate) documents, 

instead of leaving them in draft status. 
 The document template editor is still available for 

your agency to create HTML documents. 
 Properties tab is the same. 
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Summary of Changes to RTF 
Documents 

 What changed? 
 Some documents have different merge fields on 

the Setup tab. 
 More editing capabilities, you can edit almost 

anywhere within the document. 
 The document looks more like a letter. 
Merge fields cannot be edited, although some name 

merge fields are editable.  
 No drop-down menus, watch for other options, i.e. 

choice or checkbox selections. 
 Ability to copy and paste table rows 
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Summary of Changes to RTF 
Documents 

 What changed? 
 Change font style, size, color and use other word 

processing features. 
 Add or remove page breaks 
 Use hyperlinks and bookmarks 
 Edit and Print from the expanded view. 
 Agencies must create and add new RTF Headers to 

the RTF documents. 
 

Hint: Review all documents prior to finalizing to 
ensure you have worded them as intended.  
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Existing HTML Workgroup 
Documents 

 Existing HTML workgroup documents, that 
were updated to RTF documents, are still 
available for workers to complete 
 If users already created these documents. 
 

Warning: The copy feature is not available. 
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What’s Next? 

 The remaining HTML documents will be 
updated to RTF documents in a later release. 

 Create the RTF Editor for document templates 
created by local agencies. 

 More editing capabilities within the document. 
 Adding more drop-down menus 
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UPDATES/CHANGES 
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Workgroup Report Changes 
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New or Updated Fields 

 Staff Activity 
 Now includes Status, Agency of Service, Location 

and Purpose as optional columns.  
 Contact/Activity  

 "Court" was added as an option to the Location 
field. 

 Person Search/Clearing  
 Default Search Option is now Starts With. 
 You can still change the search preference as 

desired and the system will hold your settings. 
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New or Updated Fields 

 Diagnostic codes 
 ICD-9 can no longer have a future Diagnosis End 

Date.  
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New or Updated Screens 

 Data Clean-up  
 When "Alcohol abuse" is selected on the Child 

Maltreatment Family Conditions tab, at least one 
workgroup client must have a substance 
involvement record in order to satisfy data clean-
up and close the workgroup. 
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New or Updated Screens 

 Repository   
 The "Order" and "Adhoc" sections of the Filter 

screen have been removed  
 Use the grid functionality to sort the data as 

desired.  
    Example: 
     If you use the Group by functionality to sort by   
    primary worker, the printed report will have a  
     page break between workers. 
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New or Updated Screens 
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Select Decision Tools on State 
Service Plans Setup Tab 

 Decision Tools from 
closed workgroups 
merge into some State 
Service Plans 
  If selected on the  Setup 

tab, now merge into the 
Child Protective Services 
Plan and Family 
Assessment Service 
Plan from associated 
closed workgroups. 

 
SSIS Worker V14.3 Release Training                  September 2014 

58 



Example 

 Once the 
decision tool is 
selected on the 
Setup tab,  
additional fields 
display below.  
 Select the 

appropriate 
options to 
merge into 
plan. 
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Important Licensing Information 

 Licensing review 
 Kin must be licensed and child in placement with 

them for 6 months prior to eligibility for Kinship 
Assistance. 

 Start licensing your RCA families and relatives 
immediately. 
 License individuals who are going for kinship or 

adoption assistance. 
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OTHER CHANGES/UPDATES  

 64-bit capability  
 Voluntary option and is not required 
 IT staff can do this to improve workers’ workstation 

performance. 
 Most useful for workers who run large amounts of 

data, i.e., reports. 
 Is only available for workstations that are 

Windows 7, 64-bit mode 
 Allows access to the full range of memory on a 

modern PC. 
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TRAINING 
SCHEDULE 
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Training Dates 

 Basics  
 October 2014 –Brainerd Lab 
10/7 - Day 1 SSIS Intake Basics  
10/8- Day 2 SSIS Case & Workgroup Basics 
10/9 - Day 3 SSIS Child Services Basics 

 November – Rochester Lab 
11/4 - Day 1 SSIS Intake Basics  
11/5 - Day 2 SSIS Case & Workgroup Basics 
11/6 - Day 3 SSIS Child Services Basics 

 December – Metro Lab 
12/9 -  Day 1 SSIS Intake Basics  
12/10 - Day 2 SSIS Case & Workgroup Basics 
12/11 - Day 3 SSIS Child Services Basics 
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Training Dates 

VA-CEP 
  September 30, 2014  - Duluth Lab  
PM session 

December 2, 2014 – Metro Lab 
PM Session 
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RESOURCES 
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Resources 
 What’s New in SSIS Version 14.3?  

 What’s New in SSIS Version 14.3? 
 Version 14.3 Detailed Release Notes 

 Version 14.3 Detailed Release Notes 
 Documents:  

 Create and Edit a RTF Document 
 List of HTML Workgroup Documents in 

Chronology 
 List of RTF Workgroup Documents in Chronology 
 RTF Headers  
 How to Create and Attach Headers to RTF Documents 
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http://www.dhs.state.mn.us/main/groups/agencywide/documents/pub/dhs16_188608.pdf
http://www.dhs.state.mn.us/main/groups/agencywide/documents/pub/dhs16_188610.pdf
http://www.dhs.state.mn.us/main/groups/agencywide/documents/pub/dhs16_189271.pdf


 
Contacts 

Renetta Walk, SSIS Trainer 
Renetta.walk@state.mn.us 

651-431-4917 
 

SSIS Help Desk 
dhs.ssishelp@state.mn.us 

651-431-4801 
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